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Topics to be discussed... 

 Review general word processing rules, 

 The elements of word processing, 

 Introduction to Microsoft Word. 
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General Word Processing Rules 
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General Word Processing Rules... 

 Follow the directions as to font, font size and font 

style, 

 One space between words and after commas, 

 Two spaces after periods and all punctuation 

ending a sentence, 

 Do not type in all CAPs unless told to do so, 

 Keep typing; the computer will go down to the 

next line automatically, 

 Press TAB once to indent a paragraph. 
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General Word Processing Rules... 

 Follow the directions as to font, font size and font 

style, 

Directions are given to you 

verbally by the teacher, written 

down on instruction sheets and 

visually on the projector screen. 

You must be able to look, read 

and listen!    
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General Word Processing Rules... 

 One space between words and after commas, 

When you type, put one space, and only one 

space between words and after commas.  In the 

example below, every dot is a place where the 

Space Bar was pressed.  
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General Word Processing Rules... 

 Two spaces after periods and all punctuation 

ending a sentence, 

When you type, always put two spaces after periods, 

question marks and exclamation points.  In the example 

below, every dot is a place where the Space Bar was 

pressed.  
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General Word Processing Rules... 

 Do not type in all CAPs unless told to do so, 

Proper names and the first word of a sentence 

get a capital letter, but not the whole word.  

I’m sure you know this but the mistake is 

made by using the CAPS LOCK key instead of 

the SHIFT key.  Use the SHIFT key to get a 

capital letter (unless more than 1 or 2 letters 

are to be capitalized.) ABCD 
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General Word Processing Rules... 

 Keep typing; the computer will go down to the 

next line automatically, 

The only time you need to press ENTER is if 

you MUST go down to the next line, such as 

when you start a new paragraph.  Otherwise, 

let the computer do the work for you!  
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General Word Processing Rules... 

 Press TAB once to indent a paragraph. 

You are aware that paragraphs must be 

indented.  When using a computer all you need 

to do to indent a paragraph is to press the TAB 

key once. 
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Topics to be discussed... 

 Review general word processing rules, 

 The elements of word processing, 

 Introduction to Microsoft Word. 
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The Elements of Word 

Processing... 
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…but first and important term. 
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…but first and important term. 

Default 
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Default... 

A default is an initial setting on your 

computer. For example, the default font 

and size in Microsoft Word 2007 are 

Calibri, size 11, and the default style is 

plain.   
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Default... 

A default is an initial setting on your 

computer. For example, the default font 

and size in Microsoft Word 2007 are 

Calibri, size 11, and the default style is 

plain.   

Everything you type appears in this font 

and size unless you instruct the computer 

to do otherwise. 
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Elements of Word Processing... 

 Line spacing, 

 Text alignment, 

 Using fonts, font sizes and font styles, 

 

18 



Elements of Word Processing... 
 Line spacing, 

 Line spacing refers to the amount of space found between the 

lines of text in a document.  The types of line spacing in Word 

2007 are… 
 1.0 (single spaced),  

 1.15 (default line spacing in Word 2007), 

 1.5, 

 2.0 (double spaced), 

 2.5, 

 3.0.  

 The most requested line spacing is double spacing.  Most 

reports and projects are to be typed this way. 

 Business letters and personal letters are always single spaced. 
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Elements of Word Processing... 

 Line spacing, 

 
This paragraph is single spaced.  This means that lines of text 

do not have any spaces between them.  Single spacing does not 

refer to the spaces between words.  REMEMBER!  You put one 

space between words and after commas. 

This paragraph is double spaced.  This means that lines of text 

have a large space between them.  You do not do this by 

pressing ENTER after each line.  REMEMBER!  You keep 

typing and let the computer go down. 
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Elements of Word Processing... 

 Line spacing, 

 
This paragraph is single spaced.  This means that lines of text 

do not have any spaces between them.  Single spacing does not 

refer to the spaces between words.  REMEMBER!  You put one 

space between words and after commas. 

This paragraph is double spaced.  This means that lines of text 

have a large space between them.  You do not do this by 

pressing ENTER after each line.  REMEMBER!  You keep 

typing and let the computer go down to the next line. 
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Elements of Word Processing... 

 Text alignment, 

 Text alignment refers to how your text fits between the left and right 

margins of a page.  Your text can be… 

 Align Text Left,  

 Center,  

 Align Text Right or  

 Justify.   

 Quite simply, text that is left aligned lines up on the left side of the 

page.  Text that is right aligned lines up on the right side of the page, 

and text that is centered lines up in the middle, or on the center of the 

page.  Justified text lines up to the left and right sides of the page.  

This is the alignment that is typically used in books. 

 The default alignment for Microsoft Word left aligned. 

 

22 



This 

text was 

typed so that 

you might be able 

to get a clearer understanding 

of how text alignment is used in a 

word processing program such as Microsoft Word. 

If this doesn’t give you a clear example of 

how text alignment works, then  

I don’t think that you will  

ever be able to 

figure it 

out. 
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to get a clearer understanding 

of how text alignment is used in a 
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how text alignment works, then  

I don’t think that you will  

ever be able to 

figure it 

out. 
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This 

text was 

typed so that 

you might be able 

to get a clearer understanding 

of how text alignment is used in a 

word processing program such as Microsoft Word. 

If this doesn’t give you a clear example of 

how text alignment works, then  

I don’t think that you will  

ever be able to 

figure it 

out. 
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This text  was typed  so that  you  might  be 

able to get  a clearer  understanding  of how 

text alignment is used in a word  processing 

program  such  as  Microsoft Word.  I f this 

text   doesn't  give  you  a  clear example of 

how   text  alignment  works,  then   I don’t 

think that you will ever be  able to  figure it 

out. 
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Elements of Word Processing... 

 Using fonts, font sizes, and font styles 

 A font is a set of characters with a particular design and size.  

There are many different types of fonts to choose from.   

 A font size is how big the letters of your document will be.  The 

size number is relative to within a particular font.  In other 

words,  size 14 in one font may not look the same as size 14 in a 

different font. 

 There are a number of different font styles (this also includes 

plain); bold, italic, and underlined are the most common ones. 

 The defaults for Microsoft Word are Calibri, 11, plain. 
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Elements of Word Processing... 
 Using fonts, font sizes, and font styles, 

 
These are Fonts... 

 Arial Rounded Mt Bold 

 Times New Roman 

 Bauhaus 93 

 Forte 

 Curlz MT 

 Monotype Corsiva 

 Wingdings 
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Elements of Word Processing... 
 Using fonts, font sizes, and font styles, 

 
These are Fonts SIZES... 

 10 

 12 

 18 

32 
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Elements of Word Processing... 
 Using fonts, font sizes, and font styles, 

 
These are Fonts STYLES... 

Bold 

 Italic 

Underline 

 plain 
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Topics to be discussed... 

 Review  general word processing rules, 

 The elements of word processing, 

 Introduction to Microsoft Word. 
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Introduction to Microsoft Word 
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Microsoft Word 
…is a word processor.  A word processor 

is software you can use to produce 

documents, including letters, reports, 

manuals, and newsletters.   
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Microsoft Word 
…is a word processor.  A word processor 

is software you can use to produce 

documents, including letters, reports, 

manuals, and newsletters.   

 

Most word processors include a built-in 

spell check and thesaurus to increase the 

accuracy and quality of a document.  
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Microsoft Word 
…is a word processor.  A word processor 

is software you can use to produce 

documents, including letters, reports, 

manuals, and newsletters.   

 

Most word processors include a built-in 

spell check and thesaurus to increase the 

accuracy and quality of a document.  

  

Another word processor is WordPerfect.  A 

very basic word processor with limited 

features is WordPad. 
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This is a typical window in Microsoft 

Word. 

This large white area is called the 

workspace. 

This is a typical window in Microsoft Word 2007. 
 
This large white area is called the document area. 
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This is the Office Button. 
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When clicked, the Office Button will 

display some of the most used 

commands, such as New, Open, 

Save, and Print.  
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The New command button is used 

when you want to start an entirely 

new document.  
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The Open command button is used 

when you want to open a document 

that you already started and saved.  
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When you first click the Save 

command button… 
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… a dialogue box will appear and you 

must tell the program where you want 

to save the file and what name you 

will give the file.  

In school, you are to save your files to 

your U: Drive directory. 
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When you first click the Print 

command button…  
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… a print submenu will appear. If you 

just want to print one copy of all 

pages of your document, then you 

should just click Quick Print. 
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Print Preview allows you to see what 

your document will look like before 

you print it. 
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The Quick Access Toolbar also has 

some of the most used command 

buttons, such as Save and Undo. 
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The Undo command button is used 

for undoing your most recent 

mistakes. 
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The title bar includes the name of 

the program and the file name of the 

document.  If the document hasn’t 

been saved yet, the name will be 

Document 1. 
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To the right of the title bar you will find the 

minimize, maximize/restore, and close buttons.   

The minimize button will make the program as 

small as it can get, while still running.   

The maximize button will make the program as 

large as it can get. 

If the program screen was resized, the restore 

button will return the previous size it was. 
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The minimize button will 

make the program as small 

as it can get, while still 

running.   
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The maximize button will make 

the program as large as it can get. 

If the program screen was resized, 

the restore button will return the 

screen to the previous size it was. 
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The Close button will shut down 

the program, but the program will 

always ask you first if you want to 

save any changes you have made.   
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In the lower right is the Zoom Bar. This is how 

you can quickly adjust how close or how far away 

the document appears.  The best view to be in is 

between 132% and 148%. 
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The Status Bar in the lower left of the screen will 

tell you what page you are on and how many 

words you have typed so far.  
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Below the title bar you find the ribbon.   
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The ribbon consists of different tabs. 

Each tab has a different set of groups 

This is the Insert tab and some of its groups. 
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This is the Page Layout tab and some of its groups. 

57 



This is the Home tab and its groups.   
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Each group is made up of Command 

buttons. 

This is the Clipboard group and its 

command buttons. 
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The Cut command is used for removing 

words or object from one part of your 

document to be placed elsewhere in 

your document. 
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The Copy command is used for making 

an exact copy of words or objects that 

can pasted elsewhere in your document 
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The Paste command is used for placing 

words or objects that were cut or copied 

from your document and pasting them 

elsewhere in your document. 
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This is the Font group. 
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The Font command is 

where you change your 

fonts. 
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The Size command is 

where you change how 

big or small your fonts 

will be. 
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The Bold command is 

used for making letters, 

words or sentences bold. 
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The Italic command is 

used for making letters, 

words or sentences italic. 
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The Underline command is 

used for making letters, words 

or sentences underlined. 
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The Change Case command 

allows you to change your 

letters, words or sentences 

from UPPER CASE to lower 

case. 

 

 
69 



This is the Paragraph group. 
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The Align Text Left command 

will align your text to the left 

page margin.  This is the 

alignment most used and is the 

default text alignment in Word. 
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The Center alignment will 

place you text centered in 

between the left and right 

page margins. 
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The Align Text Right will 

align your text to the right 

page margin. 
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This Justify command will 

align your text to both the left 

and the right page margins.  

Careful!  This is not the same 

as center alignment. 
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The Show/Hide¶ command 

will display non-printing 

characters that show you 

everywhere you pressed the 

Tab key, the Space bar, and the 

Enter button. 
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Remember... 

 READ…directions on the Shared Drive and 

slides on the Smartboard. 

 LISTEN…to directions from the teacher. 

 Save your work to your U: Drive student 

directory on the network! 

 Typing…BOTH HANDS! 
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You have completed this slide 

show.  Did You... 

 Complete your worksheet? 

 Write your name and section at the top? 

 Answer all the questions? 
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Please notify the teacher that you 

are done so that you maybe given 

further instructions. 
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